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IInnssttaalllliinngg  iinnssttrruuccttiioonnss  ffoorr  rroottaarryy  eennccooddeerrss    
 
It is imperative to read these instructions before setting the encoder in operation.  
This encoder is a precision measuring instrument. Always observe the information and instructions of the 
data sheet to ensure trouble-free function and to maintain warranty claims. Unless otherwise stated in the 
data sheet, the following has to be absolutely observed:  

 
Mechanical:  

• It is not permissible to dismantle the encoder entirely or in part or to modify it. 
• Do not alter the shaft (by grinding, sawing, drilling, etc.), otherwise the accuracy of the encoder and 

the dependability of bearing and gasket will suffer. We are prepared to discuss special designs. 
• Never align the instrument with a hammer. 
• It is imperative to avoid impact loads. 
• Radial and axial load capacity as stated in the data sheet have to be observed under any 

circumstances. 
• Do not connect encoder and drive rigidly to one another at shafts  and  flanges. Always use a 

coupling (between drive shaft and encoder shaft, or between hollow-shaft encoder flange and drive 
flange). 

We recommend that you use our assembly aids and couplings to install the encoder (see accessory data 
sheets). 
 
Electrical: 
  
1. The existing safety devices for electrical installations have to be observed. 

• Before setting in operation, connect all required strands as per data sheet. To prevent short-circuits, 
neatly insulate the ends of all strands which are not required. 

• When preassembling the mating connector, comply with any instructions accompanying the 
connector. 

• Our recommendations regarding cable lengths: 
• in case of asymmetrical transmission, i.e. inverted signals are not used, cable length max. 

10 m 
• in case of symmetrical transmission (e.g. to RS 422), cable length max. 50 m (cable with 

twisted pairs of wires). 
• Plug in or pull out mating connector at the encoder only when encoder is deenergized. 
• Make certain that the operating voltage is correct and the max. permissible output current is not 

exceeded (see data sheet). 
• The operating voltage for encoder and succeeding device must be turned on and off together. 2. In 

order to obtain CE-Conformity, EMC installation conformity should be observed. Shielded cables 
should be used for control lines. In case of symmetrical transmission (e.g. RS 422) a cable with 
twisted pairs of wire has to be used. The cable shield should if possible be connected fully enclosed 
(360’) by shielded connectors or cable bushings. This has to be done at the encoder and transmission 
end. 

• The protection earth should be put with low impedance on both face and back of the encoder and the 
transmission end. 

• In case of earth loop problems, the protection earth of the encoder side has to be removed. On this 
occasion, the encoder should be placed electrically isolated opposite the actuation. 

• The encoder lines should run separately to cables with high noise levels. 
• Consumer with high disturbance level, e.g. frequency converters, solenoid valves, contactors etc. 

should not be connected to the same voltage supply. Otherwise, a suitable voltage filtering has to be 
installed.  

 
Safety precautions:  
 
1. If operation without danger can no longer be assured at some point, the unit must be shut 

down and secured against accidental activation. 
2. If personal injury or damage to equipment is possible should the encoder fail or malfunction, this must 

be prevented by suitable safety precautions such as protective devices or limit switches, etc. 
 
 

We can assume no warranty if the above directives are disregarded.  We ask for your 
understanding. 
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IInnttrroodduuccttiioonn  aanndd  EEnnccooddeerr  FFeeaattuurreess  
 
Based on the integrated CAN-Bus interface (CAN ISO/DIS 11898) the encoder supports all the 
following DeviceNet functions 
 

• Polled mode 
• Cyclic mode 
• Change of state mode (COS) 
• Combination of Polled mode and Cyclic mode 
• Combination of Polled mode and COS mode 
• Offline connection set 
• Device heartbeat 

 
Polled mode and Cyclic mode can be used at the same time with programmable time 
intervals in cyclic mode. 

 
The Multiturn encoder support the following programmable parameters: 
 

• Code sequence 
• Measuring units per revolution 
• Total measuring range 
• Number of distinguishable revolutions (multiturn part) 
• Preset value 

 
Parameter Object 

 
Instance  Name  Access 

1  Code Sequence  r/w 

2  Scaling Function Control  r/w 

3 Position Format ro 

4 Measuring units per Revolution  r/w 

5  Total Measuring Range  r/w 

6  Position Measuring Steps  ro 

7  Preset Value  r/w 

8 Position Value ro 

9 Operating Status ro 

10  Single Turn Resolution  ro 

11  Number of distinguishable revolutions  r/w 

12 Alarm Flag ro 

13 Generated Alarms ro 

14 Supported Alarms ro 

15 Warning Flag ro 

16 Generated Warnings ro 

17 Supported Warnings ro 

18 Serial Number ro 

 
 ro = read only parameters 
 r/w = read/write parameters 
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Readable Information about Status of the encoder: 
  
    Position Sensor Object 
 
Instance  Name  

111 Operating status 

112 Physical Resolution Span  

113 Number of spans  

114 Alarms  

117 Warnings  

120 Operating Time  

122 Min.Position value 

123 Max.Position Value  

 
 
 
 
11..00  DDeevviicceeNNeett  BBuuss  IInntteerrffaaccee  
 
1.1 DeviceNet Bus Terminal Box 

The incoming and the outgoing bus line are directly connected to the bus terminal by the 
M12 connectors. For all the adjustments made to DeviceNet 
 

• Loosen the 4 (9080) or 3 (5860) hexagon screws and draw off the 
bus terminal box 

• adjust the MAC-ID  
• adjust the baud rate 
• select the bus termination 

 
 
 
1.2  Dip switch S2-6 Bus termination   
 An internal bus termination resistor of 121 Ohm is selectable by a dip switch S2-6 
 

 
 

 
 

 * by default 

Switch S2 value state termination 
6  On on 
6  Off off* 
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1.3 Setting of the Baud rate 
The baud rate can bet set by means of the DIP switches S2 1-3 or by means of software. 
 

Baud rate 125 kBit/s  
 

Switch S2 value state Baudrate 
1 20 Off 125 Kb 
2 21 Off  
3 22 Off  

 
Baud rate 250 kBit/s 
 

Switch S2 value state Baudrate 
1 20 On 250 Kb 
2 21 Off  
3 22 Off  

 
Baud rate 500 kBit/s 
 

Switch S2 value state Baudrate 
1 20 Off 500 Kb 
2 21 On  
3 22 Off  

 

 
Baud rate and MAC-ID programmable * 
 

Switch S2 value state Programmable 
1 20 On programmable 
2 21 On  
3 22 Off  

 * by default 
 
 
 

1.4  Setting the MAC-ID (Node address) 
During device initialization, the Node Address switches shall be read by the device firmware. The 
addressable range is from 0..63. Each MAC-Id should be used only once inside a network, so all 
DeviceNet node are required to participate on a duplicate MAC-ID detection algorithm.  
 
Example:  MAC-ID #09 
 

Switch S1 value state 
1 20 On  
2 21 Off 
3 22 Off 
4 23 On  
5 24 Off 
6 25 Off 

 
Example: MAC-ID #35 
 

Switch S1 value state 
1 20 On 
2 21 On 
3 22 Off 
4 23 Off 
5 24 Off 
6 25 On 
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11..44..11  ““OOuutt--ooff--bbooxx””  ccoonnffiigguurraattiioonn  **  
MAC-ID address and Baud rate programmable by default 

 
Standard DIP-Switch S1 setting is all in „ON“-position, S2[1+2]  in “ON” 

 
 i.e. the resulting MAC-ID = 63 
       and Baud rate = 125 Kbit/s   
 

 
Switch S1 value state 
1 20 On 
2 21 On 
3 22 On 
4 23 On 
5 24 On 
6 25 On 

 

    + 
 

Switch S2 value state Programmable 
1 20 On programmable 
2 21 On  
3 22 Off  

  
* by default 
 
 
 
1.5  Connectors and Cabeling (M12 *1 eurofast® Field Wireable Connectors) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pin number color Pinout 
1 GREY shield drain wire 
2 RED + VDC 
3 BLACK -  VDC 
4 WHITE CAN_H 
5 BLUE CAN_L 

 
 
 

Kübler offers a comprehensive product family of ready-to-use Devicenet cables, 
which make network installation easy, shorten commissioning times and reduce wiring 
mistakes.  
Note:   See our special M12 Devicenet connection technology catalogue 
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22..00  OObbjjeecctt  DDeeffiinniittiioonn        
PPOOSSIITTIIOONN  SSEENNSSOORR  
CCllaassss  CCooddee  6644  hheexx  

  
Device: Encoder  Device type: 00 hex  (Generic Device)  
 
Encoders are used to detect positions of any kind of machines. These devices could be used for 
following applications: Sensing of angles, distances, tracks, velocity and motion control.  
This profile covers the measuring principle of absolute and incremental systems as well as the 
mechanical specification of rotary and linear devices. The detected physical position could be 
calculated by the device and functionalities like cams, work area switches offers an intelligent 
position detection.  

 
2.1 Class Attributes  
 
Attribute 
ID  

Implementat
ion  

Access  Name  Data 
Type  

Description  Semantics  

1  Required  Get Revision UINT Revision of this 
object  

The current value 
assigned to this 
attribute (0x02)  

 
2.2. Instance Attributes  
The required attributes ensure common base functionality for all encoders (revision 2.0) 
 

Attribute 
ID  

Access  
Rule  

Name  DeviceNet  
Data Type  

Description of 
Attribute  

Semantics of Values  

100  Get  number of 
attributes  

UINT Number of Attributes 
supported  

Default = 23 

101 Get  Attributes List  Array of 
USINT  

List of Attributes 
supported  

 

102 Get  position Value  DINT5  Current position for 
Revision > 1.  

The content is based 
upon 
105,107,108,110,113  

103 Get position sensor type  UINT specifies the encoder 
type  

Default = 11  
Multiturn 

104 Get/Set  direction counting 
toggle  

BOOL  Direction control for 
counting. Changing this 
value shall change the 
position relative to 
physical movement.  

Default = 0 

105 � Get/Set  scaling function 
control 

BOOL  Physical resolution [62] 
is converted in 
software to a numerical 
value  

0 = OFF (Default) 
1 = ON   

106 Get position format ENGUINTS  Format of the position 
value of other 
attributes. 

Supported units: counts 
(default )  
0x0800-0x0FFF = vendor 
specific  

107 � Get/Set  measuring units per 
span 

UDINT  Number of 
distinguishable steps 
per one complete span. 
Less than or equal to 
physical resolution 
[62].  

For rotary devices a span 
equal one revolution.  

108 � Get/Set  total measuring 
range in measuring 
units  

UDINT  Steps over the total 
measuring range. Only 
used for rotary 
encoders.  

 

109 Get Position measuring 
increment  

UDINT  Specifies the smallest 
incremental change of 
the Position Value 
attribute.  

Units depend on Position 
Format attribute. Default 
= 1.  

110 � Get/Set  preset value  UDINT Output position value is 
set to Preset Value. 
What does this mean?  
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111 Get  operating status  BYTE  Encoder diagnostic  
Contain operating 
status  

Bit 0  
0 = Positive  
1 = Negative  
Bit 1  
0 = Diagnostic not supp.  
1 = Diagnostic supp.  
Bit 2  
0 = Scaling OFF  
1 = Scaling ON  

112 Get physical resolution  
span  

UDINT  Number of 
distinguishable steps 
per one complete span. 
Less than or equal to 
physical resolution   

For rotary devices a span 
equals one revolution.  

113 � Get /Set number of spans  UINT  This is equal to the 
number of turns when 
a rotary type device is 
used 

Default = 4096  

114 Get alarms   WORD  Malfunction could lead  
into an incorrect 
position value  

Bit 0  
0 = NO Position error  
1 = Yes Position error  
Bit 1  
0 = Diagnostic OK  
1 = Diagnostic Error  
Bit 2 ...11 reserved  
Bit 12-15  
manufacturer specific  

115  Get supported alarms  WORD  Information about 
supported alarms  

Bit 0  
0 = No Position error  
1 = YES Position err  
Bit 1  
0 = No Diagnostic  
1 = YES Diagnostic  
Bit 2 ...11 reserved  
Bit 12-15  
manufaturer specific  

116 Get  alarm flag  BOOL  Indicates if an alarm 
error occurs,  
depends on alarms 
Attr. 114  
 

0 = OK  
1 = Alarm error  

117 Get warnings  UINT  Internal parameters 
exceeded  

See attribute semantics 
section.  

118 Get Supported  
warnings  

WORD  Information about 
supported warnings  

See attribute semantics 
section.  

119 Get warning flag  BOOL  indicates if an warning 
error occurs  
(logical OR connection 
of all bits, depends on 
warnings Attr. 117)  

0 = OK  
1 = Warning flag  

120 Get  operating time  UDINT  stores operating time 
for the encoder in 
tenths of an hour  

 

121 Get offset value  DINT  The Offset value is 
calculated by the 
preset function. Shift 
position value with the 
calculated value  

 

122 Get manufacturer 
minimum position 
value  

DINT values given in steps, 
only changeable by 
manufacturer.  

 

123 Get manufacturer 
maximum position 
value  

DINT values given in steps, 
only changeable by 
manufacturer.  

 

124 Get device serial 
number  

DINT serial number  manufacturer  sn. 

 
�Attributes, which affects the position value 
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22..33  AAttttrriibbuutteess  aanndd  tthheeiirr  mmeeaanniinngg  
 
2.3.1  Position Sensor Type – Attribute 103  
 
value  Definition  

00  Single Turn resolver (value if attribute is not supported)  

01  Single-Turn absolute rotary encoder  

02  Multi-Turn absolute rotary encoder  

03  Single-Turn absolute rotary encoder with electronic turncount  

04  Incremental rotary encoder  

05  Incremental rotary encoder with electronic counting  

06  Incremental linear encoder  

07  Incremental linear encoder with electronic counting  

08  Absolute linear encoder  

09  Absolute linear encoder with cyclic coding  

10  Multi-Sensor encoder interface  

11  Multi-Turn absolute rotary encoder with electronic turn count  

12… 65535  Reserved by DeviceNet  
 
2.3.2  Scaling Function Control – Attribute 105 
When the scaling function control attribute is set to ON (1), the position value attribute is 
converted in software to change the physical resolution of the encoder.  
If this attribute is implemented and turned OFF, all functions within position sensor shall 
continue to use the scaled value, except the Position Value reported (attribute 102) shall be the 
raw, unscaled value.  
The “Measuring units per revolution” and “Total measuring range in measuring units” attributes 
are the scaling parameters.  
 
 

If scaling function control =  OFF  
Position value = physical resolution of device in counts  

If scaling function control = ON  
Postion value = physical resolution of device in counts *  
(measuring units per span[16] / Physical resolution [63] )  

 
 
2.3.3  Measuring units per revolution – Attribute 107  
The “Measuring units per revolution” sets the number of distinguishable (desired) steps per unit 
of travel. Rotary units would contain the counts per one complete revolution. This parameter is 
only used for rotary units. 
  
2.3.4  Total Measuring Range  – Attribute 108  
The parameter “Total measuring range in measuring units” sets the number of distinguishable 
steps over the total measuring range. This value must be less than maximum physical 
resolution of the device. Maximum physical resolution should be listed on the type plate.  
This parameter is used for rotary and linear devices. 
 
2.3.5  Position measuring increment – Attribute 109  
This attribute may be supported when position format [14] can be set to a value other than 
count (0x1001). The “Position measuring step” attribute defines the measuring step settings for 
the position for linear encoders. Basic position measuring step in 0.001 µm or 0.1nanoinch is 
affected by attribute position format.  
 



© Fa.Kübler GmbH Zähl-und Sensortechnik  Seite  10 

2.3.6  Preset Value – Attribute 110  
The Preset Value supports adaption of a desired position value to an actual position value. The 
position value attribute is set to the “Preset value” (desired position value) by setting this 
attribute and the offset from the current position value is calculated and stored in the encoder.  
 
 
2.3.7  Operating status – Attribute 111 
This attribute contains the operating status of the encoder. It gives information on device 
internal programmed parameters. 
  
2.3.8  Physical Resolution – Attribute 112  
This is the physical resolution of the position sensor. For rotary encoder the number of steps per 
revolution can be read out. In nanometer or 0,1 ninch the measuring step is given for linear 
encoder. 
  
2.3.9  Number of disting. revolutions – Attribute 113 
With this attribute the number of distinguishable revolutions, that the position sensor device can 
output, is readable. For a multiturn device the number of distinguishable revolutions and the 
Physical resolution (Single-Turn Resolution )gives the physical measuring range to the formula 
below. The maximum number of distinguishable revolutions is 65535 (16 bits).  
 

Physical Measuring range = Physical Resolution (Single-Turn resolution) * 
Number of distinguishable revolutions  
 

Remark: For Single-Turn encoder the number of distinguishable revolutions is 1.  
 
2.3.10 Alarms – Attribute 114 
With this attribute alarm information is provided. An alarm is set if a malfunction bit is set to 
logic true (high) until the alarm is cleared and the encoder is able to provide an accurate 
position value. 
  
Bit  Description  FALSE (0)  TRUE (1)  
0  Position error  NO  YES  

1  Diagnostic error  NO  YES  

2…11  Reserved by 
DeviceNet  

  

12…15  Vendor specific    
 
2.3.11 Supported Alarms – Attribute 115 
Attribute contains information on supported alarms by the position sensor device. 
  
Bit  Description  FALSE (0)  TRUE (1)  
0  Position error  Not supported  Supported  

1  Diagnostic error  Not supported  Supported  

2…11  Reserved by 
DeviceNet  

  

12…15  Vendor specific    
 
2.3.12 Alarm flag – Attribute 116 
Indicates, if an alarm error occurs, depending on alarms attribute 114. 
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2.3.13 Warnings – Attribute 117 
The Warnings attribute indicates that tolerance for certain internal parameters of the encoder 
have been exceeded. In contrast to alarms, warnings do not imply incorrect position values. All 
warnings are cleared if the tolerances are again within normal parameters. For the operating 
time limit warning (bit 3) the warning is only set again after a power-on sequence. The Warning 
Flag attribute indicates if any of the defined warnings are active.  
 
Bit  Description  FALSE (0)  TRUE (1)  

0  Frequency Exceeded  NO  YES  

1  Light Control reserve  Not reached  Error  

2  CPU Watchdog  OK Reset  generated  

3  Operating Time Limit Warning  NO  YES  

4  Battery charge  OK  Too low 

5  Reference Point  Reached  Not reached  

10-12  Reserved by DeviceNet    

13-15  Vendor specific    
 
2.3.14  Supported Warnings – Attribute 118  
Attribute contains information on supported warnings by the position sensor device.  
 
Bit  Description  FALSE (0)  TRUE (1)  

0  Frequency Exceeded  Not supported  Supported  

1  Light Control reserve  Not supported  Supported  

2  CPU Watchdog  Not supported  Supported 

3  Operating Time Limit Warning  Not supported  Supported  

4  Battery charge  Not supported  Supported 

5  Reference Point  Not supported  Supported  

10-12  Reserved by DeviceNet    

13-15  Vendor specific    
 
2.3.15 Warning flag – Attribute 119  
Indicates, if an warning error occurs, depending on warnings attribute 117. 
  
2.3.16 Operating Time – Attribute 120 
This attribute contains the encoder operating time. The operating time monitor stores the 
operating time continues to increment as long as the encoder is powered. The operating time 
value is presented in tenths (0.1) of an hour.  
 
2.3.17 Offset Value – Attribute 121  
The offset value attribute is calculated by the preset function and shifts the position value 
attribute with the calculated value. The offset value is stored automatic by the device and can 
be read from the encoder for diagnostic purposes.  
 
2.3.19 Min/Max Position Value – Attribute 122-123  
These attributes are given in number of steps according to the basic resolution of the encoder 
and are located in write protected memory area only changeable by the encoder manufacturer.  
These values define the minimum and maximum physical measuring position within measuring 
range.  
2.3.18 Serial Number – Attribute 124  
This attribute gives information on the series number of the device 
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22..33..2200  DDiiaaggnnoossttiicc  aanndd  mmaallffuunnccttiioonn  iinnddiiccaattoorr  ((LLEEDD’’ss))  
 
 

 
State MOD (green LED) NET  (red LED) 
   
Selftest passed 
only activated when connected to a 
DeviceNet bussystem 

flashrate 0.5 sec flashrate 0.5 sec 

   
Encoder is in Offline state 
Encoder has not performed the 
DUP_MAC_Check 
Encoder has no power 

off off 

   
Encoder has made a DUP_MAC_Check 
and is now ONLINE 
Device needs commissioning or 
Configuration is missing or incorrect 

flashing off 

   
Device is in operational state 
I/O connection is established 

on off 

   
Recoverable Fault or 
I/O Connection is in Timed-out state 

on or flashing flashing 

   
Critical Fault or critical link failure 
 

off/on on 

   
Communication fault 
DUP_MAC_CHECK not successfull 
 

off on 

   
Offline Connection Set 
Identify Comm. faulted request message 
 
 

flashrate 0.25 sec flashrate 0.25 sec 

 
 
 
2.3.21 EDS-File and Encoder Programming 
 
 
An Electronic-Data-Sheet (EDS) File is attached to the delivery program to facilitate 
device configuration and field installation. This file is the essential in programming with 
the DeviceNet-Manger® or RSNetWorx®- tools. 
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33..00  OObbjjeecctt  MMooddeell    
 
 
 
 
 

Object modules

Multiturn Encoder 9080/58XX
Encoder profile

Position Sensor Object Class #64h

#6
#5

#4
#3

#2
#1

#67
#0A

#2

#1

Positon Sensor
Object Class #64h

Instance #1

Parameter Object
Class #0Fh
Instances
#01..#18

Identity
Object

Class #01h

DeviceNet
Object

Class #03h

Message
Router Object

Class #02h

Connection Object
Class #05h

Application
Attributes 100-124

Parameter
Instances #1-#18

#64 #65

COS
Instance

#4

Explicit
Msg

Instance
#1

Instance
Position

Instance
Position
& Status

Instance 100 Position
Instance 101 Position

       & Status

Position

Polled
I/O

Instance
#2

#03

� Predefined Master/Slave Connection Set
� Connection Instance #4 COS I/0
� Connection Instance #2 Polled  I/O
� Connection Instance #1 Explicit Msg
�
� Group 2 Only UCCM Explicit
� DUP Mac Check
� Device Heartbeat
� Offline Connection Set

Group 2 Only Device

Assembly
Object

Class #04h

 
 
 
 
 
 

This object model represents an encoder device: 
 

Object Class  Implementation  Number of Instances  

Identity  Required  1  

Message Router  Required  1  

DeviceNet  Required  1  

Connection  Required  at least 1 - Explicit, 1 I/O  

Assembly  Required  2  

Parameter  Optional  18 

Position Sensor  Required  24 
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3.1 How Objects Affect Behaviour  
The objects supported for the encoder affect the device’s behavior as shown in the table 
below. 

Object  Effect on Behavior  

Identity  Supports the reset service  

Message Router  No effect  

DeviceNet  Configures port attributes  

Connection  Contains the number of logical ports into the device  

Assembly  Defines I/O data format and configuration data format 

Parameter  Provides a public interface to the encoder configuration data  

Position Sensor  Affects Position Value (attribute)  
 
3.2 Defining Object Interfaces  

The objects supported for the encoder have the interfaces listed in the table below. 

  

Object  Interface  

Identity  Message Router  

Message Router  Explicit Messaging Connection Instance  

DeviceNet  Message Router  

Connection  Message Router  

Assembly  Message Router or I/O Connection Instance  

Parameter  Message Router  

Position Sensor  Message Router, Assembly Object or Parameter Object  

 
 
3.3 I/O Assembly Instances  

The following table identifies the I/O Assembly instances which should be supported by the 
encoder device. 

 

  

Number  Required / 
Optional  

Type  Name  

100  Required  Input  Position Value  

101 Optional  Input  Position Value & Warning Flag & Alarm Flag  
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3.4 I/O Assembly Data Attribute Format  

The I/O assembly data Attributes have the format shown below.  
 

Instance  Byte  Bit7  Bit6  Bit5  Bit4  Bit3  Bit2  Bit1  Bit0  

100  0  Position Value    LSB 

 1          

 2          

 3   MSB 

101 0  Position Value   LSB 

 1          

 2          

 3   MSB 

 4  Optical 
Fault 

Position 
Error 

low 
Battery 

Reserved by DeviceNet  Warning 
Flag  

Alarm  

Flag  

 
 
 
3.5 Mapping I/O Assembly Data Attribute Components  

The following table indicates the I/O Assembly Data Attribute mapping for the Encoder Profile.  
 
Data Component Name  Class   Instance  Attribute   

 Name  Number  Number  Name  Number  

Position Value  Position 
Sensor  

0x64  1  Position Value  102 

Warning Flag  Position 
Sensor  

0x64  2  Warning Flag  119 

Alarm Flag  Position 
Sensor  

0x64  2 Alarm Flag  116 

Low Battery Position 
Sensor 

0x64 2 Operating 
Status 

111 

Position Error Position 
Sensor 

0x64 2 Operating 
Status 

111 

Optical Fault Position 
Sensor 

0x64 2 Operating 
Status 

111 

  
 
 
 
3.6 Defining Device Configuration  

Public access to the Position Sensor Object by the Message Router must be supported for 
configuration of the encoder. If supported, the optional Parameter Object may be used to 
access the encoder’s configuration parameters. Each instance of the Parameter Object is linked 
to a specific configurable attribute or attributes within the Position Sensor Object.  

If the Parameter Object is supported a minimum of the Parameter Stub attributes are required 
with the support for Full Parameter Attributes being optional.  
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3.7 Parameter Object Instances  

The following table indicates the Parameter Object Instances supported by encoder devices.  
 
 
Instance  Name  

1  Code Sequence  

2  Scaling Function Control  

4 Measuring units per Revolution  

5  Total Measuring Range  

7  Preset Value  

11 Number of distinguishable revolutions  
 
 
 
 
3.8  Common Services  
The Position Sensor Object provides the following common services.  
 
Service Code  Implementation   Service Name  Description  

 Class  Instance    

0x0E  Conditional*  Required  Get_Attribute_Single  Returns the contents of a 
single specified attribute  

0x10  Optional  Optional  Set_Attribute_Single  Modifies a single specified 
attribute  

0x05  Optional  N/a  Reset  Resets all parameter 
values to the factory 
default  

0x15  Optional  N/a  Restore  Restores all parameter 
values from non-volatile 
storage  

0x16  Optional  N/a  Save  Saves all parameter to 
non-volatile  
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44..00  RRSSNNeettWWoorrxx  
 
RSNetWorx for DeviceNet, ControlNet, and EtherNet/IP provide you with many common 
features. Using RSNetWorx, you can: 
 

• Browse a network automatically and determine what is 
present on that network via the industry-leading RSLinx 
communication package (the RSNetWorx installation CDROM 
includes RSLinx). 
• Use the Electronic Data Sheet (EDS) services provided by 
the software to configure device parameters and to install 
support for new devices. The EDS subsystem enables 
multi-vendor interoperability on each of the networks. 
• Define the input/output information exchanges that will take 
place on the network. 
• Configure peer data exchanges (for example, controller to controller). 
 

Most DeviceNet devices are factory commissioned with default values per the DeviceNet 
specification. Usually, the node address is set to 63 and the data rate is set to 125K baud. As 
long as the factory default parameters do not conflict with those of other devices already on the 
network, you can connect the new device to the network and then use the Node Commissioning 
tool within the RSNetWorx for DeviceNet software to change the node address and data rate.  If 
the data rate conflicts, use a separate network to commission the device or a local connection 
between the device and the PC.  Some devices do not support software-based node 
commissioning. For those devices, the product will have some alternative way (for example, 
thumbwheel switches), to set the address and data rate. See the specific device’s 
documentation for more information. 
 

OOfffflliinnee  mmooddee  
Step 1 – Create a new configuration and describe your network topology 
The first step in using RSNetWorx for DeviceNet in the offline mode is to create a new DeviceNet 
configuration (by selecting File > New). Once you create the configuration, an empty network 
displays in the Configuration view.  Next, describe your network topology by dragging a device 
or scanner from the Hardware view and dropping it in the network configuration. Repeat this 
process until you have defined your entire DeviceNet network in the software.  If you would like 
to see a tabular view of the information, select the Spreadsheet tab or the Master/Slave tab. 
Step 2 – Configure the DeviceNet network 
After creating your configuration, you can edit your network properties. 
Editing network properties includes entering a network name and description. 
Step 3 – Configure the DeviceNet devices 
After configuring your DeviceNet network, you can configure the devices on the network. To 
configure a device, select a device in the configuration view and choose Device > Properties 
from the main menu. Configuring your devices consists of tasks like: 
! configuring general device properties ! editing and monitoring device parameters 
In addition you can also view I/O message data and the contents of the EDS file. 
At various times, you may want to save the work you have 
completed on your network configuration. To save a 
configuration file (*.dnt), click File > Save. 
 
Step 4 – Configure the DeviceNet scanner 
When you have completed your device configuration(s), you can then configure the scanners on 
your DeviceNet network. Configuring your scanner includes advanced tasks like configuring a 
scanlist (a list of the devices that you want the scanner to scan), and mapping device input and 
output data. In addition, you may also want to configure general device properties, specify 
module parameters (including scan-time related items), or view a summary of the scanner 
configuration. 
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Step 5 – Save your network configuration 
The final step is to save your DeviceNet configuration information to a file. To save your 
configuration file (*.dnt), select File > Save. Your DeviceNet devices are now configured and 
ready to use. 
You can use the RSNetWorx for DeviceNet software to further customize your DeviceNet 
configuration. For example, you can re-assign node addresses, modify a device’s configuration, 
etc. 
 

EEDDSS--bbaasseedd  ddeevviicceess  
RSNetWorx for DeviceNet relies on an 
electronic data sheets (EDS) for 
configuring devices. An electronic data 
sheet is an ASCII file that is created by 
the manufacturer and supplied with the 
device.  As long as the EDS file for the 
device you want to configure is 
registered with the RSNetWorx for 
DeviceNet software, you can configure 
its properties (attributes) and how it will 
communicate with other devices on the 
DeviceNet network. Although the 
procedure for configuring a device is 
basically the same for all devices, each 
device will have a unique set of 
properties. 
 
 
 

  
  
EEDDSS  lliibbrraarryy  

The electronic data sheet (EDS) library 
is a collection of EDS files that have 
been registered with RSNetWorx for 
DeviceNet. The EDS files, which are 
provided by the device manufacturers, 
contain configuration and identification 
information for the devices.  RSNetWorx 
for DeviceNet software can access only 
those devices that have been registered. 
You must use the EDS Wizard for 
registering EDS files for unknown 
devices, or if you have updated EDS files 
to install. To access the EDS Wizard, 
select Tools > EDS Wizard. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



© Fa.Kübler GmbH Zähl-und Sensortechnik  Seite  19 

RReeggiissttrraattiioonn  aa  ssiinnggllee  ffiillee  
 

Register an unknown device with an 
EDS-File. 
 
Select the file path and the named file 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Change the graphic image associated 
with a device icon if necessary . 
 
There are Bitmaps according the the 
specific device on the support disc. 
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RRSSNNeettWWoorrxx  MMaaiinnssccrreeeenn  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
PPaarraammeetteerr  aaddjjuussttmmeennttss  
 

 
This is the primary device identification information 
as interpreted from the device file. This information 
includes name of the vendor, type of product, name 
of the device, catalog number and the firmware 
revision code. 
Click right on the icon to get information about 
properties of the according device. 
 
The address is the node address of the selected 
device. This address will be used throughout the 
RSNetWorx. 
Change the MAC-Address to avoid conflict inside the 
DeviceNet. 
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PPaarraammeetteerrss  uunnggrroouuppeedd  

 
The list shows the number, name and current value 
of each parameter of the specified device. 
Keep in mind, that when the lock icon follows the 
number, the parameter is read only. 
 
When the scale icon follows the number, the 
parameter is a scaled value. 
 
Upload button: 
Click this button to upload the value of the specific 
parameter(s) from the device to the software. You 
must be online to use this button. If not, the button 
is grayed out. 
 
Download button: 
Upload button: 
Click this button to upload the value of the specific 
parameter(s) from the device to the software. You 
must be online to use this button. If not, the button 
is grayed out. 

 

  
  
PPaarraammeetteerr  GGrroouuppss  
 

Parameters  are organized into groups for 
configuration, Diagnostic, Supported options 
and special Encoder settings. 
 
These groups are determined by the EDS-file for the 
device. 
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EEnnccooddeerr  DDiiaaggnnoossttiiccss  
  

Parameter 16, e.g., 
“Pending  Warnings” 
will show under “Current 
Values” some bits set to 
0 or 1. When following 
icon next to the value is 
pressed: 
 

  
 
the drop down list 
shows boxes that are 
checked if condition is 
“TRUE”. 

This parameter is updated 
in real time by the device. 

  
  

  
 

CCoonnffiigguurraattiioonn  
 

When the scaling function control attribute is 
set to ON (1), the position value attribute is 
converted in software to change the physical 
resolution of the encoder.  
 
Resolution per revolution –  sets the number 
of distinguishable (desired) steps per unit of 
travel. Rotary units would contain the counts per 
one complete revolution. This parameter is only 
used for rotary units. 
 
Total Resolution -  in measuring units” sets the 
number of distinguishable steps over the total 
measuring range. This value must be less than 
maximum physical resolution of the device. 
Maximum physical resolution should be listed on 
the type plate. 
This parameter is used for rotary and linear 
devices. 
 
Preset Value - the Preset Value supports 
adaption of a desired position value to an actual 

position value. The position value attribute is set to the “Preset value” (desired position value) 
by setting this attribute and the offset from the current position value is calculated and stored in 
the encoder. 
 
With this attribute the number of distinguishable revolutions, that the position sensor 
device can output, is readable. For a multiturn device the number of distinguishable revolutions 
and the Physical resolution (Single-Turn Resolution )gives the physical measuring range to the 
formula below. The maximum number of distinguishable revolutions is 65535 (16 bits).  
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Physical Measuring range = Physical Resolution (Single-Turn resolution) * Number of 
distinguishable revolutions. 
Remark: For Single-Turn encoder the number of distinguishable revolutions is 1.  

EEnnccooddeerr  SSeettttiinnggss  
 

Operating Time – This attribute contains the 
encoder operating time. The operating time 
monitor stores the operating time continues to 
increment as long as the encoder is powered. The 
operating time value is presented in tenths (0.1) 
of an hour.  
Offset Value – The offset value attribute is 
calculated by the preset function and shifts the 
position value attribute with the calculated value. 
The offset value is stored automatic by the device 
and can be read from the encoder for diagnostic 
purposes.  
Min/Max Position Value – These attributes are 
given in number of steps according to the basic 
resolution of the encoder and are located in write 
protected memory area only changeable by the 
encoder manufacturer.  
These values define the minimum and maximum 
physical measuring position within measuring 
range.  
Serial Number –  This attribute gives information 

on the series number of the device 
 
 

II//OO  DDaattaa  cchhaarraacctteerriissttiiccss  
 

Displays the parameter(s) that the device will use  
for I/O messaging. 
The default message type is bold. This data, which is 
supplied by the manufacturer of the device, is 
obtained form the EDS-File. 
 
For detailed information about the message type, 
expand one or more message types. 
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55..00  TTeecchhnniiccaall  DDaattaa  
 
5.1 Mechanical characteristics: 
 
 Type 9080 
 

Shape:     round, with radial interface mounting surface 
External diameter:    max. 90 mm 
Total length:     max. 60 mm 
Hollow shaft diameter:  Up to 28 mm 
Rotational speed:   min. 1500 min-1 (for IP 65) 
Protection according to 
EN60529:    IP65 
Operating temperature range:  min. -20° C up to +80° C 
Shock resistance according 
to DIN-IEC 68-2-27:   2500 m/s2, 6 ms 
Vibration resistance 
according to DIN-IEC 68-2-6:   100 m/s2, 10...2000Hz 

 
Connection type:  M12 Connectorsystem for CAN-BUS and supply voltage 

  
 

Type 5860 
 

Shape:     round, with radial interface mounting surface 
External diameter:    max. 58 mm 
Total length:     max. 60 mm 
Shaft diameter:   6 or 10 mm 
Rotational speed:   max. 6000 min-1 
Protection according to 
EN60529:    IP65 
Operating temperature range:  min. -20° C up to +80° C 
Shock resistance according 
to DIN-IEC 68-2-27:   2500 m/s2, 6 ms 
Vibration resistance 
according to DIN-IEC 68-2-6:   100 m/s2, 10...2000Hz 

 
Connection type:  M12 Connectorsystem for CAN-BUS and supply voltage 

 
5.2 Electrical characteristics 
 

Encoder interface:    DeviceNet Release 2.0 Field Bus system  
Bus interface:     CAN Highspeed according to ISO/DIS 11898 
     Optocoupler  
Resolution:     Programmable Resolution  max.25 Bit Multiturn 

 Physical Resolution:   13 Bit Singleturn (8192 steps) 
      12 Bit Multiturn (4096 steps) 
 Linearity:    +/- ½ LSB (+/-1 LSB bei 25 Bit Multiturn) 
 Type of code:    Binary 
 Position update cycle:  every 1,0 ms 

Supply voltage:    10-30 VDC, max.120 mA 
Protocol:     DeviceNet Profile for Encoder V 2.0 (partly) 
     based on DeviceNet Release 2.0 
     Programmable Resolution, Revolution, Scaling,Direction 
 
Baudrate:    125,250,500kbit/sec 
MAC-ID:    settable via 6 Bit DIP-switch 
     Baudrate and MAC-ID fully programmable 

    Offline Connection Set 
    Device Heartbeat 
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MMuullttiittuurrnn  TTyyppee  55886600  CCAANNooppeenn//DDeevviicceeNNeett

YYoouurr  bbeenneeffiitt
• ·Connection via M12 connector terminal so less

time is spent on connection or service
• · Patented Integrative Technology means 3-

times greater shock resistance than is standard
in the market

• · Multiturn step with patented Intelligent-
Sensing-Technology (I-S-T) leads to higher ope-
rating safety even under difficult operating con-
ditions

• available as explosion proof zone 2
and 22

PPrroodduucctt  ffeeaattuurreess
•• CCAANNooppeenn  aaccccoorrddiinngg  ttoo  pprrooffiillee  DDSSPP  440066

wwiitthh  aaddddiittiioonnaall  ffeeaattuurreess
•• DDeevviicceeNNeett  22..00  pprroottooccooll
• Division: up to 8192 bits per revolution, up to

4096 resolutions (31 x 12 bits)
•  Programmable parameters
• IP 65
• Housing diameter ø 60 mm
• Shaft ø 6 or 10 mm
• Comprehensive M12 range of accessories

MMeecchhaanniiccaall  cchhaarraacctteerriissttiiccss::

EElleeccttrriiccaall  cchhaarraacctteerriissttiiccss::

Speed1): max. 6000 min-1

Rotor moment of inertia: approx. 1,8 x 10-6 kgm2

Starting torque shaft version: < 0,01 Nm
Load capacity of shaft am Wellenende: radial: 80 N, axial: 40 N
Weight: appr. 0,7 kg
Protection acc. to EN 60 529: IP 65
Working temperature: –20° C ... +80 °C
Operating temperature: –20° C ... +85 °C
Shaft: stainless steel
Shock resistance acc. to DIN-IEC 68-2-27: 2500 m/s2, 6 ms
Vibration resistance acc. to DIN-IEC 68-2-6: 100 m/s2, 10 ... 2000 Hz

Supply voltage (UB): 10 ... 30 V DC
Current consumption: max. 0,29 A
Recommended fuse: T 0,315 A
Linearity: ± 1/2 LSB (±1 LSB at resolution 13, 14, 25 ,26 Bit)
Code: Binary
Interface: CAN HIGH-Speed to ISO/DIS 11898, Basic and 

Full-CAN; CAN specification 2.0 B (11 and 29 Bit 
Identifier)

Protocols: CCAANNooppeenn  PPrrooffiill  DDSSPP  440066  
wwiitthh  aaddddiittiioonnaall  ffuunnccttiioonn
DDeevviicceeNNeett  PPrrooffiillee  ffoorr  EEnnccooddeerr  RReelleeaassee  VV  22..00

Rate: programmable via DIP switches 10 ... 1000 Kbits/s
Basic identifier: programmable via DIP switches
Conforms to CE requirements acc. to EN 50082-2, EN 50081-2 and EN 55011 Class B and EN 61000-4-8
Performance against magnetic influence acc. to EN61000-4, 5

1) for continous operation 3000 min-1 at the max. temperature

CCAANNopen

Rotary Measuring Technology
Absolute Multiturn Encoder with CANopen/DeviceNet interface
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MMuullttiittuurrnn  TTyyppee  55886600  CCAANNooppeenn//DDeevviicceeNNeett

TThhee  ffoolllloowwiinngg  ffuunnccttiioonnaalliittyy  iiss  iinntteeggrraatteedd::
• Class C2 functionality
• NMT Slave
• Diagnostics (internal) 2 Bit
• CAN-LED for Bus status
• CAN-LED for operating mode

CCAANNooppeenn  --  DDeevviiccee  PPrrooffiillee::
GGeenneerraall  ddeessccrriippttiioonn

The CANopen Device Profiles describe the
functionality of the communication and of
that part of the CANopen fieldbus system
specific to the manufacturer.  Device Profile
406 applies to encoders and defines the
individual objects independently of the
manufacturer.  In addition the profile makes
provision for additional extended functions
specific to the manufacturer; using devices
that interface with CANopen offers the
advantage of acquiring systems today that
are prepared for the needs of the future.

TThhee  ffoolllloowwiinngg  ppaarraammeetteerrss  
ccaann  bbee  pprrooggrraammmmeedd::
• Polling mode or auto mode

with adjustable time
• Direction
• Number of pulses/rotation 1 ... 8192
• Number of revolutions 1 ... 4096
• Total resolution 
• Preset
• Offset

TThhee  ffoolllloowwiinngg  ffuunnccttiioonnaalliittyy  iiss  iinntteeggrraatteedd::
• Galvanic isolation of the Fieldbus-stage

with DC/DC converter
• Addressing via DIP switches or software
• Diagnose-LED Netzwerk und Mode
• Baud rate 125, 250 and 500 kbit/s pro-

grammable via DIP switches
• Node address 0 … 63 and baud rate pro-

grammable via DIP switches
• Polled mode 
• Cyclic mode
• Change of state mode (COS)
• Combination of Polled mode and 

Cyclic mode
• Combination of Polled mode and 

COS mode
• Offline connection set
• Device heartbeat
• “Out of box” Config
• MAC-ID and Baud rate preset value

MAC-ID = 63

DDeevviicceeNNeett  EEnnccooddeerr  PPrrooffiillee::
GGeenneerraall  ddeessccrriippttiioonn::
The DeviceNet Device Profile describes the
functionality of the communication and of
that part of the DeviceNet fieldbus system
specific to the manufacturer.  The Encoder
Profile applies to encoders and defines the
individual objects independently of the
manufacturer.  In addition the profile makes
provision for additional extended functions
specific to the manufacturer.
TThhee  ffoolllloowwiinngg  ppaarraammeetteerrss  ccaann  bbee  
pprrooggrraammmmeedd::

• Direction of rotation
• Scaling factor

- number of pulses/rotation
- Total resolution

• Number of revolutions
• Preset value
• Diagnostics mode
• Resolution

• Baud rate = 125 kBits/s
• 2 I/O Assembly

Position value
Position value and atatus

FFiieellddbbuuss  eennccooddeerrss  ccaann  bbee  uusseedd  iinn  tthhee  ffoolllloo--
wwiinngg  aapppplliiccaattiioonnss::

CCAANNooppeenn::
Elevators, construction and 
mobile plant, cranes, 
agricultural vehicles, 
pecial-purposes vehicles.

DDeevviicceeNNeett::
especially suitable for 
applications in the USA.

Rotary Measuring Technology
Absolute Multiturn Encoder with CANopen/DeviceNet interface
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MMuullttiittuurrnn  TTyypp  55886600  CCAANNooppeenn//DDeevviicceeNNeett

Terminal assignment M12:

1

4

3

5

21

4 5

3

2 Signal : DRAIN + V DC – V DC CAN_H CAN_L
Pin: 1 2 3 4 5

GY RD BK WH BU

Bus out:

Signal : DRAIN + V DC – V DC CAN_H CAN_L
Pin: 1 2 3 4 5

GY RD BK WH BU

Bus in:

60

36
f8

20

19

5,1
1,5

76,3
10

14,6
63,2

0,1 A

0,2 A

0,1 A

A

50

60

10
h8

9

48
±0

,0
5

(3x) 120° 1

DDiimmeennssiioonn::

Synchronous flange

Clamping flange

(3x) M3, 5 deep1

50
h7

58 60

5,1

19

1,5

3

3

4
76,3

83,8

10

14,6
69,2

0,2 A

0,1 A

0,1 A

A

50

60

6
h8

5,5

42
±0

,0
5

(3x) 120° 1

(3x) M4, 5 deep1

Bus in: Bus out:

Bus in

Bus out:

Rotary Measuring Technology
Absolute Multiturn Encoder with CANopen/DeviceNet interface
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MMuullttiittuurrnn  TTyyppee  55886600  CCAANNooppeenn//DDeevviicceeNNeett

OOrrddeerr  ccooddee:: 0088..55886600..XXXXXXXX ..XX000011

Range

Flange
1 = Clamping flange
2 = Synchronous flange

Shaft
1 = Shaft ø 6 x 10 mm 
2 = Shaft ø 10 x 20 mm

Interface and supply voltage
1 = DeviceNet 10 ... 30 V DC.
2 = CANopen 10 ... 30 V  DC

Field bus profile
1001 = DeviceNet 2.0
2001 = CANopen Encoder 

Profile DSP 406

Type of connection
1 = Terminal box with 

cable connection M161)

2 = M12-connector
1) only at CANopen version

IInncclluuddeess::
EDS-file and documentation on CD

Kübler is working consistently aatt  hhiigghh  iinnttee--
ggrraattiioonn  ooff  aallll  uunniittss and intelligent sensing
systems. The basics of our encoders are
two patented technologies:

PPaatteennddeedd  ""IInntteeggrraatteedd  TTeecchhnnoollooggyy®®””  uusseess
ssiinnggllee  bbooaarrdd  ccoonnssttrruuccttiioonn,,  ddeelliibbeerraattee
aasssseemmbbllyy  tteecchhnniiqquueess,,  aanndd  ttwwoo  AASSIICC  ddeessiiggnn::
• Shock up to 250gs
• Higher vibration specs and thermal 

shock performance
• Lower parts count, elimination of 

potentiometers
• Higher resistance to EMI

EElleeccttrroonniicc  mmuullttiittuurrnn  iinnccrreeaasseess  ppeerrffoorrmmaannccee,,
eelliimmiinnaatteess  ggeeaarrss  
• Reliability - No backlash errors, resistant

to EMI, lower parts count
• Higher life - No mechanical wear, lower

internal temperature
• Higher performance - Higher operating

speeds
• Lower profile - compact size, hollow shaft
• Economical - Lower cost

PPaatteennddeedd  ""IInntteelllliiggeenntt  SSeennssiinngg  TTeecchhnnoollooggyy®®""
• Multiturn design that protects encoder

from EMI.
• The battery outlasts both application

requirements and system components
(LEDs & bearings)

• Redundant multiturn sensors and counters
increase reliability & life

• Active system output monitoring  using
digital filters to compare data to logical &
target bits.

Rotary Measuring Technology
Absolute Multiturn Encoder with CANopen/DeviceNet interface
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MMuullttiittuurrnn  TTyyppee  99008800  CCAANNooppeenn//DDeevviicceeNNeett

YYoouurr  bbeenneeffiitt
• Only 60 mm clearance needed
• Patended integrative technology
• Very easy mounting of the hollow shaft

version. The encoder is mounted directly
on the drive shaft without coupling. This
saves up to 30 % cost and 50 % clearance
compared to shaft versions.

• Divisions: up to 8192 (13 bits) per revolu-
tion, 4096 (12 bits) revolutions

• Contactless multiturn gear with new
Intelligent-Sensing-Technology (IST)

• Simply connection patent pending con-
necting system with removable socket box

• Protection: IP 65
PPrroodduucctt  ffeeaattuurreess
• CANopen according to profile DSP 406 with

additional features
• DeviceNet 2.0 protocol
• Divisions: up to 8192 Bit/U, up to 4096 U. 

(13x12 bit)
• IP 65
• Extensive M12 accessories program 
• available as explosion proof zone 2

and 22MMeecchhaanniiccaall  cchhaarraacctteerriissttiiccss::
Speed: 1) max. 6000 min-1

Rotor moment of inertia: appr. 72 x 10-6 kgm2

Starting torque shaft hollow shaft version : < 0,2 Nm
Starting torque shaft shaft version : < 0,05 Nm
Load capacity of shaft (bei Vollwelle) 2) radial: 80 N, axial 40 N
Weight: appr. 0,9 kg
Protection acc. to EN 60 529: IP 65
Working temperature: –10° C ... +70 °C
Operating temperature: –20° C ... +80 °C
Shaft: stainless steel
Shock resistance acc. to DIN-IEC 68-2-27: 2500 m/s2, 6 ms
Vibration resistance acc. to DIN-IEC 68-2-6: 100 m/s2, 10 ... 2000 Hz

1) for continuous operation 3000 min-1
2) shaft version only (at shaft end)

EElleeccttrriiccaall  cchhaarraacctteerriissttiiccss::

Supply voltage (UB): 10 ... 30 V DC
Current consumption: max. 0,29 A
recommended fuse: T 0,315 A
Linearity: ± 1/2 LSB (±1 LSB at Resolution 13, 14, 25 ,26 Bit)
Codeart: Binary
Interface: CAN HIGH-Speed to ISO/DIS 11898, Basic and 

Full-CAN; CAN-specification 2.0 B (11 and 29 Bit 
Identifier

Protocol: CCAANNooppeenn  ttoo  PPrrooffiill  DDSSPP  440066  
DDeevviicceeNNeett  PPrrooffiillee  ffoorr  EEnnccooddeerr  RReelleeaassee  VV  22..00

Rate: programmable via DIP switches 10 ... 1000 Kbits/s
Basic identifier/node: programmable via DIP switches
Conforms to CE requirements acc. to EN 50082-2, EN 50081-2, EN 55011 Class B and EN 61000–4–8
Performance against magnetic influence acc. to EN61000-4, 5

CCAANNopen

Rotary Measuring Technology
Absolute Multiturn Encoder with CANopen/DeviceNet interface
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FFiieellddbbuuss  eennccooddeerrss  ccaann  bbee  uusseedd  iinn  tthhee  ffoolllloo--
wwiinngg  aapppplliiccaattiioonnss::

CCAANNooppeenn::
Elevators, construction and 
mobile plant, cranes, 
agricultural vehicles, 
pecial-purposes vehicles.

DDeevviicceeNNeett::
especially suitable for 
applications in the USA.

TThhee  ffoolllloowwiinngg  ffuunnccttiioonnaalliittyy  iiss  iinntteeggrraatteedd::
• Class C2 functionality
• NMT Slave
• Diagnostics (internal) 2 Bit
• CAN-LED for Bus status
• CAN-LED for operating mode

CCAANNooppeenn  --  DDeevviiccee  PPrrooffiillee::
GGeenneerraall  ddeessccrriippttiioonn

The CANopen Device Profiles describe the
functionality of the communication and of
that part of the CANopen fieldbus system
specific to the manufacturer.  Device Profile
406 applies to encoders and defines the
individual objects independently of the
manufacturer.  In addition the profile makes
provision for additional extended functions
specific to the manufacturer; using devices
that interface with CANopen offers the
advantage of acquiring systems today that
are prepared for the needs of the future.

TThhee  ffoolllloowwiinngg  ppaarraammeetteerrss  
ccaann  bbee  pprrooggrraammmmeedd::
• Polling mode or auto mode

with adjustable time
• Direction
• Number of pulses/rotation 1 ... 8192
• Number of revolutions 1 ... 4096
• Total resolution 
• Preset
• Offset

TThhee  ffoolllloowwiinngg  ffuunnccttiioonnaalliittyy  iiss  iinntteeggrraatteedd::
• Galvanic isolation of the Fieldbus-stage

with DC/DC converter
• Addressing via DIP switches or software
• Diagnose-LED Netzwerk und Mode
• Baud rate 125, 250 and 500 kbit/s pro-

grammable via DIP switches
• Node address 0 … 63 and baud rate pro-

grammable via DIP switches
• Polled mode 
• Cyclic mode
• Change of state mode (COS)
• Combination of Polled mode and 

Cyclic mode
• Combination of Polled mode and 

COS mode
• Offline connection set
• Device heartbeat
• “Out of box” Config
• MAC-ID and Baud rate preset value

MAC-ID = 63

DDeevviicceeNNeett  EEnnccooddeerr  PPrrooffiillee::
GGeenneerraall  ddeessccrriippttiioonn::
The DeviceNet Device Profile describes the
functionality of the communication and of
that part of the DeviceNet fieldbus system
specific to the manufacturer.  The Encoder
Profile applies to encoders and defines the
individual objects independently of the
manufacturer.  In addition the profile makes
provision for additional extended functions
specific to the manufacturer.
TThhee  ffoolllloowwiinngg  ppaarraammeetteerrss  ccaann  bbee  
pprrooggrraammmmeedd::

• Direction of rotation
• Scaling factor

- number of pulses/rotation
- Total resolution

• Number of revolutions
• Preset value
• Diagnostics mode
• Resolution

• Baud rate = 125 kBits/s
• 2 I/O Assembly

Position value
Position value and atatus



160 www.kuebler.com

45

m
ax

.
41

80
h7

4
6

57

14,5
1

73

14
6,

5

m
ax

. 
28

90

28

60

50
12

0°

M6x10

2

3

60

5 4

4
N

9

12
h7

23

R2

30

6

MMuullttiittuurrnn  TTyyppee  99008800  DDeevviicceeNNeett

DDiimmeennssiioonn  (M12 connector version):

M12 Connectors/Coupling

Spring device for pin acc. to DIN 6325 Ø6
Spring device short (Flange No. 2)
Spring device l0ng (Flange No. 3)
Slotted hole for screw M4
Mounting bracket (Flange No. 4)
2,5 mm deep7

6

5

4

3

2

1

1

4

3

5

21

4 5

3

2 Signal : DRAIN + V DC – V DC CAN_H CAN_L
Pin: 1 2 3 4 5

GY RD BK WH BU

Bus out:

Signal : DRAIN + V DC – V DC CAN_H CAN_L
Pin: 1 2 3 4 5

GY RD BK WH BU

Bus in:Bus in: Bus out:

Bus in

Bus out:

Rotary Measuring Technology
Absolute Multiturn Encoder with CANopen/DeviceNet interface
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MMaaxx..  ppeerrmmiissssiibbllee  ddrriivvee  sshhaafftt  iimmppaacctt
Type of flange: Permissible axial impact                    Permissible radial impact          Perm. angular play
Flange Typ 2 (Spring device short): max. ±1 mm1) max. ±0,3 mm                               max. ±2°
Flange Typ 3 (Spring device long): ∞2) max. ±0,3 mm max. ±2°
Flange Typ 4 (Mounting bracket): max. ±0,5 mm max. ±0,3 mm max. ±2°

OOrrddeerr  ccooddee:: 0088..99008800..XXXX XXXX..XX000011

Range

Flange
1 = without mounting aid
2 = with short spring device
33  ==  wwiitthh  lloonngg  sspprriinngg  ddeevviiccee
44  ==  wwiitthh  mmoouunnttiinngg  bbrraacckkeett

Shaft/Hollow shaft
11  ==  HHoollllooww  sshhaafftt  øø  1122  mmmm
2 = Hollow shaft ø 15 mm
33  ==  HHoollllooww  sshhaafftt  øø  2200  mmmm
4 = Hollow shaft ø 24 mm
55  ==  HHoollllooww  sshhaafftt  øø  2288  mmmm
6 = Hollow shaft ø 5/8"
7 = Hollow shaft ø 1"
8 = Shaft ø 12 x 30 mm
9 = Hollow shaft ø 16 mm

Interface and supply voltage
1 = DeviceNet 10 ... 30 V DC
22  ==  CCAANNooppeenn  1100  ......  3300  VV    DDCC

Feldbusprofil
1001 = DeviceNet
22000011  ==  CCAANNooppeenn  EEnnccooddeerr  

PPrrooffiillee  DDSSPP  440066

Type of connection
1 = Terminal box with 

cable connection M161)

2 = M12-Connector
1) only at CANopen version

AAcccceessssoorriieess::

Further accessories see accessories 
chapter

IInncclluuddeess::

ESD-file and documentation on CD

L 

1231)When mounting the encoder make sure
that the dimension Lmin. is larger than the
maximum axial play of the drive in the
direction of the arrow. Danger of mecha-
nical collision! Flange

Spring device
Pin3

2

1

123

Flange

Spring device
Pin3

2

1

PPaatteennddeedd  ""IInntteeggrraatteedd  TTeecchhnnoollooggyy®®””  uusseess
ssiinnggllee  bbooaarrdd  ccoonnssttrruuccttiioonn,,  ddeelliibbeerraattee
aasssseemmbbllyy  tteecchhnniiqquueess,,  aanndd  ttwwoo  AASSIICC  ddeessiiggnn::
• Shock up to 250gs
• Higher vibration specs and thermal 

shock performance
• Lower parts count, elimination of 

potentiometers
• Higher resistance to EMI

EElleeccttrroonniicc  mmuullttiittuurrnn  iinnccrreeaasseess  ppeerrffoorrmmaannccee,,
eelliimmiinnaatteess  ggeeaarrss  
• Reliability - No backlash errors, resistant

to EMI, lower parts count
• Higher life - No mechanical wear, lower

internal temperature
• Higher performance - Higher operating

speeds
• Lower profile - compact size, hollow shaft
• Economical - Lower cost

PPaatteennddeedd  ""IInntteelllliiggeenntt  SSeennssiinngg  TTeecchhnnoollooggyy®®""
• Multiturn design that protects 

encoder from.
• The battery outlasts both application

requirements and system components
(LEDs & bearings)

• Redundant multiturn sensors and counters
increase reliability & life

• Active system output monitoring  using
digital filters to compare data to logical &
target bits.

Rotary Measuring Technology
Absolute Multiturn Encoder with CANopen/DeviceNet interface

2)Pin through hoe
of spring device
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